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ABSTRACT  
SAS® 9.4M5 covers the basics of PDF accessibility, and many simple reports might be accessible without 
any additional work. However, if you produce reports that use advanced reporting features and 
accessibility is a requirement, you might need to provide additional manual accessibility remediation 
beyond the automatic accessibility features provided in SAS 9.4M5. This paper identifies advanced 
features that might require remediation and teaches you how to address those gaps using Adobe Acrobat 
Pro. 

INTRODUCTION  
SAS 9.4M5 has the ability to create PDF files with a significant amount of accessibility support built into it. 
It does this by inserting collections of tags that translate visual layouts and presentations into structures 
that assistive technologies, such as screen readers, can interpret. SAS 9.4M5 will automatically add 
much of the tagging information for items such as tables and images for you. However, there still might be 
additional work that needs to be done in Acrobat Pro in order to make the document fully accessible 
according to the WCAG 2.0 Level AA specification. Common elements in reports that might need 
additional accessibility remediation are: 

• Image and graph descriptions 

• How repeated headers and footers are presented to screen reader users 

• Table summaries (descriptions) 

• Row and column headings in tables 

• Setting the correct number of columns per row for some tables 

• Reordering document tags for some lists 

This paper details how to use Acrobat Pro to determine what additional accessibility information needs to 
be added to the document and how to use the tools within Acrobat Pro to make your document 
accessible. 

ASSUMPTIONS 
This paper assumes that output is generated with SAS 9.4M5 with the ACCESSIBLE option in the ODS 
statement 

ODS PDF file="my report.pdf" ACCESSIBLE; 
 

SAS allows a tremendous amount of flexibility in the type of output that can be generated. This paper 
assumes that best practices have been followed in regards to user-generated content. For example, the 
PDF destination allows programmers to create “headings” of content with the Hn statements in PROC 
ODSTEXT . 

PROC ODSTEXT CONTENTS=""; 
 H1 "My Report"; 
RUN; 
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This code creates a heading tag in the PDF document that helps meet the WCAG 2.0 1.3.1 Info and 
Relationships requirement. This allows screen readers to know that this item is a heading as opposed to 
plain text, and thus the screen reader user can know when they have entered a new section of the 
document and what the title of this section is. 

It is possible to also create text that looks like headings using text formatting techniques, but this text will 
not meet accessibility requirements since in the tagging structure this text will appear identical to all the 
other plain text: 

 
TITLE1 "^{style [fontsize=28pt] My Report}" 

 

This paper does not cover how to make text like this accessible in Acrobat Pro since it could easily be 
made accessible using techniques already available in SAS. This paper concentrates on accessibility 
tasks that are not available directly through SAS and need to be performed in Acrobat Pro. 

The guidance in this document is based on the requirements of WCAG 2.0 Level AA conformance. 

For guidance on best practices in creating accessible PDF files, refer to the Recommended Reading 
section at the end of the paper. 

GETTING STARTED 
Adobe has multiple products related to PDF documents. Not all of them allow you to edit accessibility 
information in documents. You need to use either of the following products: 

• Acrobat XI Pro 

• Acrobat Pro DC 

These are versions of Acrobat that must be purchased. Acrobat Reader, which is free, will not allow you 
to edit the accessibility information within PDF documents. Also, the Preview application within OS X does 
not have the ability to edit accessibility information. Acrobat Pro is available for both Windows and OS X. 

Note: All of the screen shots in this paper use Acrobat XI Pro for Windows. 

SETTING UP YOUR ENVIRONMENT 
There are a few tools that you will use repeatedly in Acrobat Pro when adding accessibility information to 
documents. The primary tools are the Order Pane (Figure 1) and the Tags Pane (Figure 2), which are 
found in the Navigation Panes, and also the Accessibility Tools (Figure 7). 
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Figure 1. Order Pane 
 

 
Figure 2. Tags Pane 
The Order Pane and Tags Pane appear on the left side of the application, but they might need to be 
added to the Navigation Pane section the first time you use them. Once you add them they will stay there. 
To add the panes: 

1. Go to the “View” menu 

2. Go to the “Show/Hide” submenu 

3. Go to the “Navigation Panes” submenu 

4. Choose “Order” 
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5. Repeat Steps 1 through 3 and then choose “Tags” 

After adding the Tags pane, open it and select the “Options” menu (Figure 3). Ensure that “Highlight 
Content” is checked. 

 
Figure 3. Highlight Content in Tags Options 
If you ever accidentally remove one of these Navigation Panes from the view, you can always add them 
again with the previous steps. You can also add the panes by control clicking on the Navigation Pane 
section in the application and choosing the pane to add. 

The Accessibility Tools are part of the larger Tools Pane (Figure 4).  
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Figure 4. The Tools Pane 
The Tools Pane is located on the right side of the application. If you do not see it, you can add it by doing 
the following: 

1. Go to the “View” menu 

2. Go to the “Show/Hide” submenu 

3. Choose “Tools Pane” 

From this point you can search for any tool within Acrobat. If you enter “accessibility” in the “Find your 
tools here” box, you will see all of the accessibility tools. 

If you want the “Accessibility” tools to always be visible on the Tools Pane, do the following: 

1. Click on the “Tools” tab near the top of the application, as shown in Figure 5. 

2. Scroll down to the “Accessibility” tool, as shown in Figure 6.  

3. Open the drop-down menu and choose “Add Shortcut.” 

 

 
Figure 5. Tools Tab 
 

 
Figure 6. Tools List 
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The accessibility tools will now be available in the right-side of the Tools Pane. When you click on 
“Accessibility” in the Tools Pane, all of the Accessibility functions will be displayed, as shown in Figure 7. 

 
Figure 7. Accessibility Tools 

SAVE EARLY, SAVE OFTEN 
Once you work much with Acrobat Pro for accessibility remediation, you quickly come across one of its 
most challenging features. There are times when the “Undo” functionality is not available. This usually 
happens when you are adding document structure through the Touch Up Reading Order tool, deleting 
tags, or if you assign an element to the “Background.” When working with PDF files and editing the 
accessibility of them, there are two important guidelines to follow: 

1. Work from a copy of the original PDF file 

2. Save your work often 

Following these two guidelines can significantly decrease frustrations that you might encounter. 

CHECKING FOR ACCESSIBILITY––KNOWING WHAT YOU NEED TO FIX 
How do you know what is accessible and what is not accessible in a PDF and thus what you have to fix? 
There are two methods for determining accessibility––automatic testing and manual testing. 
The ideal testing tool would be able to automatically determine all accessibility problems within a 
document. There are many aspects of accessibility testing that computers can do quite well, but 
accessibility testing has many aspects that cannot be easily accomplished by computer algorithms. There 
are many accessibility tests that require humans to interpret what information is being presented and how 
the context of that information influences its understanding by users, especially for screen reader users. 

For example, computers can determine if an image includes a text alternative that can be presented to 
users who cannot see the image. If the alternative text is missing, the computer can inform you of the 
omission. However, computers are not good at determining if the text alternative accurately describes the 
image. If you have an image of a dog and the text alternative is “cat” a computer would tell you that the 
image passes because a text description is present. 

AUTOMATIC TESTING 
Adobe Acrobat provides a set of automated accessibility tests that it can perform. These can be accessed 
in the Accessibility Tool on the right side of the Tools Pane. 

1. Select “Accessibility” from the right side of the Tools Pane. 

2. Select “Full Check” to bring up the “Accessibility Checker Options” (Figure 8). 
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3. The default options will usually suffice for accessibility testing. 

4. Select “Start Checking.” 

 
Figure 8. Full Check––Accessibility Checker Options 
When it is done, the “Accessibility Checker” Pane will appear on the left (Figure 9). The report is a series 
of expandable sections showing which tests passed and which failed. 
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Figure 9. Full Check Accessibility Report 
To fix problems directly from here: 

1. Control click on an item from the report 

2. Select “Fix” (Figure 10) 
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Figure 10. Fixing Errors from within the Report 
Repeating this for every failure in the report will guide you through how to fix each issue. Note, there are 
some issues that will always show that a manual check is required. “Logical Reading Order” and “Color 
contrast” are two examples as these are two tests that cannot be accurately determined by the software. 

WHAT DOES ACROBAT PRO AUTOMATICALLY CHECK? 
Acrobat Pro’s “Full Check” contains many automated accessibility tests. Some of the tests will not apply 
to PDF files generated by ODS, but it is fine to still run them. Each of Acrobat Pro’s tests and how they 
relate to ODS PDF output are outlined in Table 1, Table 2, Table 3, and Table 4. 

Test How it Relates to SAS ODS PDF Output 

Accessibility permission flag is set This enables assistive technologies like screen readers to 
interact with the document. SAS sets this automatically. 

Document is not image-only PDF This test will always pass for PDF files that are generated by 
SAS, because SAS does not create image-only PDF files. 

Document is tagged PDF This test will always pass for PDF files that are generated by SAS 
if you use the ACCESSIBLE option in the ODS PDF statement. 

Document structure provides a 
logical reading order 

The results of this test will indicate that a manual check needs to 
be performed. The document generated by SAS will be 
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Test How it Relates to SAS ODS PDF Output 

structured in the order that items are written to the PDF. This will 
result in a document structure that is in a logical reading order.  

The exception to this is if you use ODS LAYOUT ABSOLUTE 
and you draw items to specific locations on the page that do not 
match the natural reading order of the document. This problem 
should be corrected in the SAS code by changing the order in 
which items are written to the document, not in Acrobat Pro.  

Text language is specified The language will always be specified based on the SAS 
DFLANG system option.  

Document title is showing in title 
bar 

A title will always be generated by SAS, but if you want to 
customize it you can set the document title with the DOCUMENT 
attribute on the ODS PDF statement. 

Bookmarks are present in large 
documents 

SAS table and graph procedures automatically generate 
bookmarks. Bookmarks can also be customized in SAS. 

Document has appropriate color 
contrast 

This check cannot be fully performed by Acrobat and must be 
manually checked. This is also not something that can be 
corrected in Acrobat Pro but must be corrected in the original 
SAS code. 

Table 1. Document Accessibility Tests 
 

Test How it Relates to SAS ODS PDF Output 

All page content is tagged Output generated by SAS will be tagged if you use the 
ACCESSIBLE option in the ODS PDF statement. 

All annotations are tagged This test does not apply since SAS does not generate PDF 
annotations. 

Tab order is consistent with 
structure order 

SAS output creates a tab order consistent with the structure 
order. However, note the description for “Document structure 
provides a logical reading order” in the previous table. 

Reliable character encoding is 
provided 

SAS automatically encodes characters correctly. 

All multimedia objects are tagged SAS does not generate multimedia objects to PDF documents. 

Page will not cause screen to 
flicker 

SAS does not generate content that will cause the page to flicker. 

Navigation links are not repetitive SAS does not generate repetitive links. 

Page does not require timed 
responses 

SAS does not generate content that requires timed responses. 

Table 2. Page Content Accessibility Tests 
 

Test How it Relates to SAS ODS PDF Output 

All form fields are tagged SAS does not generate PDF forms. 

All form fields have description SAS does not generate PDF forms. 
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Test How it Relates to SAS ODS PDF Output 

TR must be a child of Table, 
THead, TBody, or TFoot 

SAS procedures that generate tables create the table structure 
correctly. 

TH and TD must be children of TR SAS procedures that generate tables create the table structure 
correctly. 

Tables must have headers SAS procedures that generate tables automatically do this for 
basic table layouts. RWI and some advanced features of 
procedures require you to follow certain processes. For more 
advanced layouts, additional accessibility work might be 
necessary in Acrobat Pro. 

Tables must contain the same 
number of columns in each row 
and rows in each column 

SAS creates tables this way; however, when using techniques 
such as the LINE statement with PROC REPORT, an 
incorrect number of columns are set for that row. 

Tables must have a summary SAS automatically generates a table summary for you and you 
can customize the summaries from within SAS code. Some 
procedures might need some further editing of their 
summaries in Acrobat Pro. 

LI must be a child of L SAS automatically constructs lists in this way. 

Lbl and LBody must be children of 
LI 

SAS automatically constructs some lists this way; however, if 
you have multiple lists in a document, the second and 
subsequent lists will need to be edited in Acrobat Pro. 

Table 3. Form, Table, and List Tests 
 

Test How it Relates to SAS ODS PDF Output 

Figures require alternate text Images inserted with RWI allow custom descriptions. Images 
inserted with other techniques will need remediation in 
Acrobat Pro. 

Alternate text that will never be 
read 

SAS does not create alternate text that will not be read. 

Alternate text must be associated 
with some content 

SAS associates alternate text with content. 

Alternate text should not hide 
annotation 

SAS does not do this. 

Elements require alternate text SAS includes alternate text on items that require it. One 
exception is if you have images in a document and you use the 
FOOTNOTE statement. 

Appropriate heading nesting SAS generates headings the way the programmer specifies. 

Table 4. Alternate Text and Headings Tests 
 

MANUAL TESTING 
So what things do you need to check in addition to the automated tests? 
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Images 
• The accuracy of alternative text for graphs and images  

• If images should be set to be ignored by screen readers 

Repeated Headers and Footers 
• If text items should be set to be ignored by screen readers 

Tables 
• If table headers and scope are defined correctly 

• If tables contain nontabular information 

List Structure 
• If more than one list is used in the document, whether the lists have the correct tagging structure. 

Document Reading Order 
• Does the document reading order match the visual presentation on the page. 

All of these checks can be made with the aid of tools within Adobe Acrobat. However, some of these 
checks can also be made by using a screen reader. The following sections describe how to use Acrobat 
Pro to perform these checks.  

ACCESSIBILITY REMEDIATION WORKFLOW 
1. Open the PDF in Acrobat Pro. 

2. Ensure that your workspace is set up as described in the above section, “Setting up your 
environment.” 

3. Run the “Full Check” to test for accessibility problems and correct those problems. 

4. Manually inspect the document to determine what else needs accessibility remediation (from the 
list in “Manual Testing”). 

5. For every item identified in Step 4: 

a. Set items to “Background” that should be ignored by screen readers. 

b. Add, edit, or delete tags as appropriate. 

HIDING ITEMS FROM SCREEN READER USERS 
Sometimes there is content on a page that you do not want to present to screen reader users. Examples 
include: 

• Background images used for decoration 

• Headers and footers repeated on each page 

• Lines used to separate sections of content 

In a PDF document, all content must be presented in the logical structure of the document, or it must be 
marked as an artifact. An artifact is something that appears visually on the page, but assistive 
technologies like screen readers will not read it to the user. 

SAS 9.4M5 does not allow the programmer to mark any item as an artifact, so if there is content that 
should not be read by screen reader users, the following steps should be used: 

1. Open the Order Pane from the Navigation Pane on the left.  
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2. Open the Accessibility Tools from the Tools Pane on the right. 

3. From the Accessibility Tools, select “Reading Order.” This opens the “Touch Up Reading Order” 
tool (Figure 11). This is the tool that has the ability to mark something as belonging to the 
“Background.” In other words, marking it as an artifact. 

4. For convenience, if it is not checked, check the “Show page contents groups.” 

5. Then select the “Structure types” radio button. 

 
Figure 11. Touch Up Reading Order Window 
If there is an item that has a highlight box around it that should not be read by screen reader users, follow 
these steps: 

1. Click the tag name in the upper left corner of the highlight box. 

2. In the “Touch Up Reading Order” tool, select “Background” (Figure 12). 

3. Repeat the above steps for every page of the document. 
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Figure 12. Marking Part of a Header as a Background Item 
Note the warning in the “Save Early, Save Often” section above. Marking an item as “Background” cannot 
be undone, and manually re-creating the structure that was just removed is not always straightforward.  

What items should you be marking as “Background”? The most common items are: 

• Repeated header and footer information, including page numbers. You can leave the header on 
the first page and the footer on the last page in the reading order and document structure, but all 
of the others should be marked as “Background.” If they are left in the reading order, it makes a 
document much more difficult for screen reader users to read because the repeated header and 
footer will be reread between every page in the document. All page numbers should be marked 
as “Background” items. 

• Decorative figures used to create stylistic separation between sections (as opposed to simply 
using white space between sections). These often include images of lines or repeated ASCII 
characters. Screen reader users have other ways of knowing when they have moved from one 
section to another rather than relying on visual cues. 

• Images that do not convey any substantive information to the document but are used purely for 
aesthetics. Screen reader users do not need to read each of these images. 

IMAGES 

WHAT IS ALTERNATIVE TEXT? 
Alternative text is a description of an image that describes to the user what information the image is 
conveying. Here are examples of types of images that need descriptions for people who cannot see the 
image: 

• Graphs 

• Company logos 

• Images included in tables to convey information 

Note: when describing images there is no need to include the word “image” or “graphic” in the description. 
Screen readers will already know that it is an image. 

 

 



15 

CREATING ALTERNATIVE TEXT DIRECTLY IN SAS 
Images inserted using the RWI Image method can be assigned alternative text descriptions. 

OBJ.IMAGE(file: "./SAS-logo.png",  
          description: "SAS" ); 
 

Graphs created with ODS graphics procedures, like SGPLOT, can also be assigned alternate text 
descriptions. 

PROC SGPLOT DATA=sashelp.class  
DESCRIPTION= "Scatter plot showing students by height and weight"; 
 

The other methods of inserting images (PREIMAGE, POSTIMAGE, and BACKGROUNDIMAGE) and 
graphs (SAS/GRAPH) cannot have their alternative text set. This must be done in Acrobat Pro. In 
addition, if an image should be ignored by screen reader users, that must be done in Acrobat Pro. 

GRAPH ACCESSIBILITY 
Graphs contain a lot of information. Describing all of that information adequately to people who cannot 
see the graph can be challenging. There are three strategies for dealing with this: 

1. Provide alternative text that briefly describes the data, including any analysis that would be 
apparent if you could see the graph. (that is, “Average student weight increases linearly as 
student height increases”) 

2. Provide alternative text that states what the graph is, but in the text within the page, ensure that a 
description of the data and analysis is present so that all users can read it. (that is, “Graph 
showing miles per gallon vs. car weight,” and then in the page text include descriptions of what 
the graph is showing) 

3. SAS has developed the SAS Graphics Accelerator, a tool that enables people to explore the 
graph and the data within the graph in interactive ways. Users can hear descriptions of the data, 
explore the exact data points within the graph, and get a sonified rendering of the graph whereby 
the data is presented as a series of musical notes. All of these modes of interaction provide a 
very rich environment for exploring data. Unfortunately, the PDF file format is limited in the ways 
that it can provide additional interactivity for graphs. The SAS Graphics Accelerator currently 
works only with the ODS HTML5 destination. In order to provide users a more immersive 
experience to understand graphs, consider also producing an HTML5 version of your graphs. 

ALTERNATE TEXT VERSUS TITLE VERSUS ACTUAL TEXT 
When adding descriptions to images there are multiple places that look like they could accept some type 
of description. It is critical to add the description to the “Alternate Text” field, not the “Title” field or the 
“Actual Text” field. The “Alternate Text” field is what is presented to screen reader users. There are four 
ways to add text descriptions to images. 

METHODS OF ADDING ALTERNATE TEXT 

Set Alternate Text Tool 
This technique uses a wizard to walk you through every image on the page. It will show you the current 
text description for each image and give you the option to edit it. This technique is the easiest and most 
straightforward way of checking images. (Figure 13) 

1. From the Accessibility Tools list on the right side of the application, choose “Set Alternate Text.” 

2. Select “OK” to the message about detecting figures in the document. 

3. For each image enter text in the “Alternate Text” field. Note that the image will be highlighted in 
the document for each image found. Sometimes the highlight and the image dimensions will not 
match exactly, but the highlight will show you the section of the page where the image is located. 

http://support.sas.com/software/products/graphics-accelerator/index.html
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4. Press the arrow in the upper right corner of the “Set Alternate Text” window to go to the next 
image. 

5. Once you have gone through all of the images, click “Save & Close.” 

 
Figure 13. Set Alternate Text Tool 
 

The Order Panel 
This technique requires you to manually navigate each page to find images. (Figure 14) 

1. Open the Order panel from the left-side Navigation Panes. 

2. As you navigate through each page you will see the currently set alternate text on top of the 
image in the Order panel. 

3. With the “Touch Up Reading Order” window open, control click on the “Figure” tag in the upper 
left corner of the image in the document. 

4. Choose “Edit Alternate Text” from the pop-up menu. 

5. Enter a description and press “OK.” 

 
Figure 14. Edit Alternate Text Option 

The Tags Panel 
This technique requires you to manually go through each page and the tagging structure to find images. 
With this process, it is easier to miss some images and requires more work. (Figure 15) 

1. Open the Tags panel from the left-side Navigation Panes. 
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2. Go through the elements of the Tags panel. 

3. Control click on the <Figure> tag and choose “Properties.” 

4. Enter a text description in the “Alternate Text” field. Note, do not enter text in the “Title” or “Actual 
Text” fields. 

5. Click “Close.” 

 
Figure 15. Editing Alternative Text from the Tag Pane 

Full Check Accessibility Test 
This process will check every image in the page to ensure that it has alternative text, but it does not check 
for the quality of the alternative text. It will only generate errors for missing alternative text. Because  SAS 
generates alternative text for every image, this test method will not be the most useful for tagged PDF 
files that are created by SAS. 

1. From the Accessibility Tools in the right-side Tools pane, select “Full Check.” 

2. Click “Start Checking.” 

3. After the check completes, the “Accessibility Checker” pane will open. In the report there will be a 
section for “Alternate Text” and inside of that, a subsection for “Figures Alternate Text.” 

4. Control click on the figure in the report. 

5. Choose “Fix” from the submenu. 
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6. This will start the “Set Alternate Text” tool noted above. 

TABLE ACCESSIBILITY 
Tables can be a challenge to understand for users who cannot see them. Tables have layouts that are 
designed to enable easy visual understanding of how each row and column relate to one another and if 
each row or column has a header that describes it. Table accessibility involves relaying those visual 
relationships to people who cannot see the table. Making tables accessible consists of two aspects: 

1. Providing descriptions of the tables 

2. Ensuring that data cells can be associated with row and column headings 

TABLE DESCRIPTIONS 
Table descriptions are useful to screen reader users because when they first come to a table, they are 
told the description of the table. This greatly aids in understanding what the table is about. 

Many SAS tables can be assigned descriptions directly within SAS code using the CONTENTS=”…” 
attribute on the appropriate statement. Table descriptions should be thought of as providing a label for the 
table. It might be as simple as CONTENTS=”Student Height By Age”. For many tables this description will 
be sufficient. However, there might be times when tables require a more detailed description in order to 
differentiate them from one another. This can be the case when printing multiple tables with a BY 
statement.  

For example, you might have a set of data on car fuel efficiency that is presented as a series of tables 
generated from a BY statement, where each table is a set of cars from a particular manufacturer and 
each table contains multiple models from that manufacturer. You could use CONTENTS=”Fuel Efficiency 
for Cars by Manufacturer” but that would be the same description for all of the tables. Users would not be 
able to easily discern the difference between each table. Instead, you might want one description to be 
“Honda Cars Fuel Efficiency” and one to be “Ford Cars Fuel Efficiency”. In these cases you will need to 
go into Acrobat Pro to set those descriptions explicitly. 

Title versus Summary versus Alternate Text 
When adding a description to the table, it is critical to add the description to the “Summary” field. This is 
the field that is supposed to be presented to screen readers. At the time of publishing this paper, the only 
screen reader that actually reads this content is NVDA. That means if you are testing for accessibility with 
a screen reader, JAWS will not read the table summary under any conditions. 

Adding Table Summaries in Acrobat Pro 
In order to add table summaries to tables, do the following (Figure 16): 

1. Open the Order Pane from the left-side Navigation Panes. 

2. Open the Accessibility Tools from the right-side Tools Pane. 

3. Click “Reading Order” to open the Touch Up Reading Order window. Note that you don’t actually 
use the Touch Up Reading Order window to make the changes, but it must be open in order for 
the correct options to appear in the main window. You can drag the Touch Up Reading Order 
window out of the way. 

4. Control click on the “Table” tag name in the upper left corner of the table.  The current table 
summary will appear as text in this same space right after the “Table –“ text. 

5. Choose “Edit Table Summary.” 

6. Enter the table summary and select “OK.” 

Note that there is no wizard for table summaries like there is for image alternative text. You must navigate 
to each table on each page and perform this process. 
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Figure 16. Editing the Table Summary from the Order Pane 

TABLE STRUCTURES 

Row and Column Headings  
When screen readers are reading through a table of data, they need easy ways to know what the labels 
for each row and column of data are. That is how they know exactly what they are reading, the context of 
the information, and what meaning it has. This is accomplished by using row and column headings. The 
row and column headings are announced to screen readers as they move from row to row or column to 
column. 

Checking for Accessible Table Structures 
Checking for correct table headers is a more difficult task in Acrobat Pro. There are two ways to do so: 

1. Manually inspect tables with the Table Editor (detailed below). 

2. Use a screen reader to test if headings are read correctly. 

Learning to use screen reading software is beyond the scope of this paper, but if you know how to use a 
screen reader, there are a couple of items that you need to be aware of as you read through a table to 
check for heading accessibility. 

1. You will need to navigate through the table using table navigation keys, not just the up, down, left 
and right arrows. You will need to press Control-Alt in addition to the up, down, left, and right 
arrow keys. 

2. As you navigate through the table, the headers for data cells will be announced when one of their 
values changes. For example, if you navigate down a column, the column heading will only be 
announced once, but the row heading will be announced every time a new row heading is 
encountered. The opposite is true when you navigate across a row. The row heading will only be 
announced once, but the new column heading will be announced as you navigate to one of the 
data cells in the new column. As you navigate the table, if you notice headings not getting 
announced when they should be announced, you might need to edit the table headings. 

3. Sometimes with row headings that span multiple rows and column headings that span multiple 
columns, screen readers will not always announce the change in the span value as you navigate 
the table. The opposite can sometimes be true also, where the spanned heading gets announced 
every time you move, even though you are still within the span of that row or column. This is not 
necessarily a problem with the tagging structure of the PDF. It is a result of how screen reading 
software and Acrobat Pro interact with each other sometimes. 

Most SAS procedures produce tables with headings already defined, so no additional work is needed. 
However, there are some ways you can make tables in SAS that will not create table headings, such as 
using the NOHEADER option on the PROC REPORT statement. Removing headings like this is not 
recommended. 
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Manually Checking and Assigning Table Headings for Simple Tables 
1. Open the Order Pane in the left-side Navigation Panes. 

2. Open the Accessibility tools in the right-side Tools pane. 

3. Click “Reading Order” to open the “Touch Up Reading Order” window. 

4. Click on the number or letter in the upper left corner of the table on the page. 

5. Click “Table Editor” in the “Touch Up Reading Order” window. At this point the table will show 
where all of the table headings (TH) and data cells (TD) are located. 

6. At this point you can inspect and change any table cell property. (See the note in “Selecting Table 
Cells in the Table Editor” in the “Notes about working in Adobe Acrobat Pro” section below.)  

7. To change a TD to a TH, control click on the cell that you want to change, and choose “Table Cell 
Properties” from the pop-up menu.  

8. For heading cells, in the “Table Cell Properties” (Figure 17), do the following: 

a. Select the radio button for “Header cell.” 

b. Define the “Scope” by saying it is a heading for either a “Row,” “Column,” or “Both” to 
indicate if it is a label for a row, column, or both. 

c. Click OK. 

 
Figure 17. Editing Table Headings in the Table Cell Properties Window 

Assigning Table Headings for Complex Tables 
Sometimes tables do not have a clean one-to-one mapping of data cells to header cells. In these cases, it 
is not possible for screen readers to automatically determine what a particular data cell’s row and column 
headings are because they might have multiple headings that are dispersed throughout the table (Figure 
18). 
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Figure 18. Table with Headings Dispersed throughout the Table 
In general, tables with complex layouts should be avoided. From an accessibility perspective, it is usually 
better to break complex tables into simpler tables where each table can have a clean one-to-one 
relationship between data cells and headings. 

If you do have a table that has a complex layout and it needs to be made accessible, use the following 
steps. Note that you might need to take additional steps under “Table Regularity” in the following section 
for headings that stretch the length of the table. 

1. Open the Order Pane in the left-side Navigation Panes. 

2. Open the Accessibility tools in the right-side Tools pane. 

3. Click “Reading Order” to open the “Touch Up Reading Order” window. 

4. Click on the number or letter in the upper left corner of the table on the page. 

5. Click “Table Editor” in the “Touch Up Reading Order” window. At this point the table will show 
where all of the table headings (TH) and data cells (TD) are located. 

6. To change a TD to a TH, control click on the cell that you want to change, and choose “Table Cell 
Properties” from the pop-up menu. (See the note in “Selecting Table Cells in the Table Editor” in 
the “Notes about working in Adobe Acrobat Pro” section below.)  

7. For header cells, in the “Table Cell Properties,” do the following: 
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a. Select the radio button for “Header cell.” 

b. Assign a unique ID in the ID field. This will be used in the next step to assign this heading 
to a particular data cell. 

c. Click OK. 

8. For data cells that need headings assigned to them, in the “Table Cell Properties” (Figure 19), do 
the following: 

a. Select the radio button for “Data cell.” 

b. Next to the “Associated Header Cell IDs” click the “+” button. 

c. From the drop-down list, select the ID of the heading that you want to assign to this cell 
(Figure 20). 

d. Repeat the previous step for each heading that you want to assign. 

e. Click OK twice. 

f. Note that the header cell IDs will not be available until you add them to header cells then 
exit the table editor mode and restart the table editor mode. 

 
Figure 19. Table Cell Properties Window 

 
Figure 20. Add Table Header ID Window 

TABLE REGULARITY 
One of the tests that Acrobat Pro performs is to ensure that each row has the same number of columns. 
This ensures that as screen readers read up and down a column, they stay in a consistent position. When 



23 

Acrobat Pro calculates the number of rows and columns, it takes into consideration row spans and 
column spans. 

For default tables, SAS generates regular tables (tables with the same number of columns in each row). 
However, some options, such as the LINE command in PROC REPORT, create an irregular table 
because the column span is not set correctly. These problems are reported by running the “Full Check.” 
In order to correct this problem use the Table Editor to set the column span for these rows. 

1. Open the Order Pane in the left-side Navigation Panes. 

2. Open the Accessibility tools in the right-side Tools pane. 

3. Click “Reading Order” to open the “Touch Up Reading Order” window. 

4. Click on the number or letter in the upper left corner of the table on the page. 

5. Click “Table Editor” in the “Touch Up Reading Order” window. At this point the table will show 
where all of the table headings (TH) and data cells (TD) are located. 

6. Note that the “Full Check” will not tell you where in the table the problem occurs. It will just tell you 
which table has an error. To find the row that has an error, start checking with rows that span the 
length of the table and use the following steps: 

a. To see the column span setting, control click on a table cell and choose “Table Cell 
Properties” from the pop-up menu. (See the note in “Selecting Table Cells in the Table 
Editor” in the “Notes about working in Adobe Acrobat Pro” section below.)  

b. Make sure the “Column Span” number correctly indicates the number of columns this cell 
stretches across. For example, if a table cell stretches across the whole table and there 
are 4 columns in the table, the column span value for that cell should be 4. 

c. Click “OK.” 

d. Click “Yes” to confirm that you want to make this change. 

7. Repeat Steps 6 for each table cell that stretches the length of the table. 

 

NON-DATA ROWS 
Another accessibility issue to consider is what type of information is presented in the table. Many tables 
are a simple layout of rows and columns where each table data cell corresponds to a row heading and 
column heading. However, it is possible in SAS to create tables where some rows do not contain data 
related to the row and column headings. These rows are often summarization rows or rows inserted to 
create visual separation in tables. 

The most common example of this is using the LINE statement with PROC REPORT. (Figure 21) 
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Figure 21. Table with Blank Lines 
In a table like this, as a screen reader traverses the table it can read through the data and understand it 
since the data is associated with row and column headings. However, when it gets to a row that does not 
contain any data, what might be obvious to a user who can see the table can leave a screen reader user 
wondering what happened to the data on this row and why it can’t be read. They will be able to read data 
in the previous row and the following row, but not this row. 

In this case, it is best if this row is not included in the table at all. There is no way to exclude a table row 
from the table directly in SAS, so it must be done in Acrobat Pro. Follow these steps to directly 
manipulate the table structure: 

1. Open the Tags Pane in the left-side Navigation Panes. 

2. Browse through the tag structure looking for the table in question. This can take some time 
depending on the size of the document. As you click on the table element, the page should scroll 
to the table in the document. If it doesn’t, make sure that you have checked “Highlight Content” in 
the Options menu (see Setting Up Your Environment). 

3. When the table is found, expand it to show all of the rows (<TR> elements). 

4. Click until you find the row that you want to remove from the structure (Figure 22). 

5. To delete it, either press the Delete key, or control click on it and choose “Delete Tag.” 

 

 

 



25 

 
Figure 22. Selecting a Blank Table Row in the Tag Pane 
Now when the screen reader user encounters this table, this row will not be included in the row count, nor 
will it be read as the user navigates through the table.  

If you have a table that contains rows generated with the LINE statement but the contents of that row are 
important, a different technique must be used to make the PDF file fully accessible. There are two 
options: 

1. Within the SAS code, generate a separate table each time a LINE statement is used so that there 
are no LINE statements associated with the tables. The information in the LINE statement can be 
placed either before or after each new table, whichever is appropriate for the context. 

2. In Acrobat Pro, you can explicitly assign each table cell to a specific heading. This is a tedious 
and time-consuming process. The process is detailed in the “Assigning Table Headings for 
Complex Tables” in a previous section. 

REORDERING TAGS FOR LIST ACCESSIBILITY 
When creating lists in PDF documents, there is a specific structure that those lists must take for a screen 
reader to render the information coherently as shown below:  

<L> 
  <LI> 

      <Lbl> 
      <LBody> 

  <LI> 
      <Lbl> 
      <LBody> 

 
The tags follow a pattern almost identical to HTML lists. Each list <L> consists of a set of list items <LI>. 
Each list item contains a label <Lbl> (usually the bullet character or a number) and a body of text 
<LBody>. 

When constructing single-level lists in SAS with PROC ODSLIST or the LIST command in PROC 
ODSTEXT, the above format gets generated. However, the second and subsequent lists will need to be 
restructured. To restructure the tags for lists use the following procedure: 

1. Open the Tags panel from the left-side Navigation Panes. 
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2. Find the list <L> in the Tags panel. Note that by clicking on the tags, the document will scroll and 
highlight the element. 

3. Expand the List by clicking on the “+” sign to the left. See the note on “Expand Collapse Icons” in 
the “Notes about Working in Adobe Acrobat Pro” section if you do not see the “+” and “-“ icons. 

4. Once it and all of its child nodes are expanded, you will see a pattern like the following (Figure 
23). 

 
Figure 23. List with Incorrect Structure 

5. Note how there is an <Lbl> and an <LBody> outside of an <LI>. The first <Lbl> and <LBody> 
actually refer to the last item in the list. However, if you open the last <LI>, you will also see an 
<Lbl> and <LBody> in there too that also refer to the last item in the list. You must delete the 
<Lbl> and <LBody> that are inside of the last <LI> and move the very first <Lbl> and <LBody> 
(the ones not inside of an <LI> inside of the <LI>). 

6. Control click on the <Lbl> in the last <LI> in the list. Choose “Delete Tag” from the pop-up menu. 
Do not delete the <LI>. 

7. Control click on the <LBody> in the last <LI> in the list. Choose “Delete Tag” from the pop-up 
menu. You should now have an empty <LI>. Do not delete the <LI>. 

8. Click on the first <Lbl> in the list (the one that is not inside of an <LI>) and drag it downward to 
place it inside the last <LI>. Note that the position and size of the insertion line are critical to 
placing the item in the correct location. The difference between placing an item as a sibling of an 
item (Figure 24) or as a child of an item (Figure 25) is seen in a slight difference in the length of 
the insertion line that gets drawn. Siblings get drawn as slightly longer lines than children. In this 
case, we want to make the <Lbl> a child of the <LI>. 

 
Figure 24. Inserting an Item as a Sibling 
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Figure 25. Inserting an Item as a Child 

 

9. Click on the first <LBody> in the list (the one that is not inside of an <LI>) and drag it downward to 
place it just after the <Lbl> inside the last <LI>. In this case, we want to make the <LBody> a 
sibling of the <Lbl>. 

Note that nested list structures are not well supported in SAS 9.4M5 and should not be used for 
accessible PDF files. Nested lists should be restructured into single-level lists.  

 

NOTES ABOUT WORKING IN ADOBE ACROBAT PRO 

MAKE ACCESSIBILITY CHANGES IN YOUR FINAL VERSION OF YOUR PDF FILE 
Accessibility changes made in Acrobat Pro should be made in the final version of your PDF that you are 
preparing to distribute. If you iteratively create new versions of the PDF file from a SAS program, your 
older version of the PDF file will be overwritten. If you made accessibility edits in a previous version of the 
PDF file, those edits will be gone. There is no way to map changes in an older version of a PDF file to a 
newer version of a PDF file. 

THINGS YOU SHOULD NOT DO IN ACROBAT PRO 
While you technically can add text and edit text to table cells directly in Acrobat Pro, you should really do 
that work directly in SAS code. This situation frequently occurs when you have a row that contains 
summation information (Figure 26) but there are no row headings describing that summary information. 
Rows containing summary information should have row headings, and those should be created via SAS 
code. 
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Figure 26. Table with a Summation Row with No Label 

READING ORDER VERSUS TAG ORDER 
The following is not a common problem but it’s important to note this behavior in case the situation does 
arise. 

In Acrobat Pro the Order Panel and Tag Panel both show an order that items are presented to the user. 
One would think that the order from one panel would always be reflected in the other panel, but this is not 
always the case. It is possible to have the items appear in one order in the Order Pane but another order 
in the Tags Pane. This usually occurs when manipulating the order of tags directly in the Tags Pane when 
an item was already in the document structure. This should be avoided if possible. In general, for ODS 
generated content, you should avoid changing how the order items appear directly in the Tags Pane, 
other than the technique noted above for List structures.  

SELECTING TABLE CELLS IN THE TABLE EDITOR 
During the process of selecting table cells within the Table Editor, you can easily get into a state where 
either the pop-up menu does not look correct or you will accidentally select multiple items to edit at once. 
Remember to save early and save often. The undo feature does not work here. In general, to make life 
easier, if you run into a problem, click on the cell you want so that it is highlighted with a box, then control 
click twice in the cell, but make the second click in a spot slightly to the left and up a pixel or two from 
your current mouse position. This will usually get the pop-up menu back and you will be editing only one 
cell. 

EXPAND AND COLLAPSE ICONS 
When working in the Tags and Order Panels, there are items that can be expanded and collapsed. 
Normally these icons look like “+” and “-“ buttons (Figure 27). However, there are times when these icons 
seem not to load correctly and they might look like very small squares (Figure 28). When this happens, 
you can still expand and collapse the sections, but it might take a little trial and error to find the exact right 
position to click to activate the expand and collapse functionality. 
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Figure 27. Expand Icon as a Plus Sign 

 
Figure 28. Expand Icon as a Small Square 

CONCLUSION 
SAS 9.4M5 provides a considerable level of support for creating accessible PDF files. For reports that 
require additional work to make features accessible, Acrobat Pro has the features necessary to make 
your reports accessible to people with disabilities and meet your requirements for accessible document 
creation. 
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